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Safety Precautions
For safe and correct usage
Thoroughly read the “Safety Precautions” and the
operation manual before using the unit. Keep them
carefully after reading and use as ready reference.

Pictorial Symbols
The “Safety Precautions” and markings on the product
contain various pictorial symbols to assure the safety
use of the product and prevent an injury to you and other
persons as well as property damage.
As each symbol has the following meanings, thoroughly
understand them before using the unit.
Please note that some precautions may not be applicable to
the product that you purchased.
CAUTION: Indicates a potentially hazardous situation that
may arise due to improper handling by taking
no notice of this symbol and could result in a
serious injury or death.
WARNING: Indicates a potentially hazardous situation that may
arise due to improper handling by taking no notice of
this symbol and could result in an injury or property
damage only.
[Note] △ means a heads-up.

Examples of symbols
Symbol “ ” means a prohibited action. The content
of prohibited matter is mentioned near or in the
figure. (The figure on the left side represents “Caution
for disassembling”.
Symbol “ ● ” means a mandatory or directive
content. Practical precautions are shown in the figure.
(The figure on the left side represents “Pull out power
plug from plug outlet.”)

CAUTION
When using the unit:
Do not place a receptacle containing water
or a small metallic piece on the unit!
If water spills in the unit, a fire or electric shock may be
caused.

Do not use other power supply voltage than
specified!
A fire or electric shock may be caused.

Do not put a metal body or flammable
material into the opening of the unit! Do not
drop in such material!
A fire or electric shock may be caused.

Do not make alterations to the unit!
A fire or electric shock may be caused.

When installing the unit:
Do not set the unit in an unstable place!
It may drop or turn down, causing an injury.

Do not connect to any other equipment than
specified!
A fire or electric shock may be caused.

When fixing the unit, ask a professional
contractor!
When fixing the unit, do so in accordance with the specified
procedure; otherwise it may drop or turn down, causing a
fire, electric shock or injury.Especially when fixing it to the
wall or ceiling, be sure to ask a professional contractor.

When an abnormal state occurs:
If the unit produces smoke, gives out a foul
smell or produces an abnormal sound, turn
off the power switch immediately and pull
out the power plug!
If the unit is used as it is, a fire or electric shock may be
caused. Check that no smoke is produced, and then contact
the dealer or sales representative.

If water or foreign matter enters the unit, turn off
the power switch and pull out the power plug!
If the unit is used as it is, a fire or electric shock may be
caused. Contact the dealer or sales representative.

If the unit is dropped or the case is broken,
turn off the power switch and pull out the
power plug!
If the unit is used as it is, a fire or electric shock may be
caused. Contact the dealer or sales representative.

If the unit fails to operate properly, turn off
the power switch and pull out the power plug!
If the unit is used as it is, a fire or electric shock may be
caused. Contact the dealer or sales representative.

Do not use any damaged power cord
(exposed core, broken wire, etc.)!
If the unit is used as it is, a fire or electric shock may be
caused. Contact the dealer or sales representative.
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WARNING
When installing the unit:
Do not place a heavy thing on the unit!
The unit may lose a balance or drop, causing an injury.

Do not get a leg over the unit or carrying
case! Do not sit down on it!
The unit may break down or turn down, causing an injury.

When moving the unit, be sure to turn off the
power switch, pull out the power plug and
remove the connecting cable between the
unit and equipment beforehand.
The cord may be damaged, causing a fire or electric shock.

When the unit is not used for a long period
of time, be sure to pull out the power plug
for safety's sake.
Otherwise, it may cause a fire.

When installing the unit:
Do not block up the ventilating hole of the unit!
If the ventilating hole of the unit is blocked up, heat will
accumulate internally, causing a fire. Avoid the following
usage:
・Turning up or down the unit. Turning it sideways.
・Pushing it in ill-ventilated place.
・Placing it on a carpet etc.
・Covering it with a table cloth etc.

Hints on proper usage
When using the unit:
When using the unit in a water-place such as bathroom,
poolside, etc., prevent water from flowing into the unit
and cable; otherwise causing an electric shock.
When using it in rainy weather, during snowing, on the seaside or
waterside, and in a cooking place, use care to prevent such an accident.

When snow comes on, check the surrounding
conditions before use. Stop using the unit
temporarily as necessary and do not touch it.
Otherwise causing an electric shock.

Do not connect any equipment whose required
electric power exceeds the wattage (W) that can be
supplied from the AC outlet.
Refer to wattage shown near the AC outlet or in the operation manual.

Do not bend (or twist or pull) the power cord and
connecting cable excessively.
The covering material of the cord and cable may break, causing an
electric shock.

When installing the unit:
Avoid installing the unit in a moist place, dusty place
or any other place exposed to oily smoke and vapor;
otherwise causing an electric shock.
Do not place the unit near a cooking table or humidifier.

As this unit is heavy (over 10Kg), carry it by 2 or
more persons.
If it is carried by one person, it may turn down or drop, some- times
causing an physical damage to the waist or hand or a physical injury.

Take preventive measures against the overturn of the
unit due to an earthquake or sudden shock.
As the unit may overturn and cause a physical injury, take preventive
measures against the overturn.

NOTE: This equipment has been tested and found to comply with the
limits for a Class A digital device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio
communication. Operation of this equipment in a residential area is likely
to cause harmful interference in which case the user will be required to
correct the interference at his own expense.
Changes or modifications not expressly approved by the party responsible
for compliance could void the user’s authority to operate the equipment.
Please classify by the material, and dispose of them according to the law
and the ordinance etc. of the country and the local government when you
dispose of the main body and materials for packing.

Instructions for Disposal of Electrical and
Electronic Equipment in Private Households
Disposal of used Electric and Electronic Equipment
(Applicable in the European Union and other European
countries with separated waste disposal and collection
methods)
This symbol on the product, or in the related documents in
the package, indicates that this product shall not be treated
as normal household waste. Instead, it should be taken to a
proper applicable collection point or depot for the recycling of
electric and electronic equipment.
By ensuring this product is disposed of correctly, you will help prevent
possible negative consequences for the environment and human health,
which could otherwise be caused by inappropriate waste handling of
this product. The recycling of materials will help to conserve natural
resources.
For more detailed information about recycling of this product, please
contact your local city authority, your household waste disposal service or
the place where you purchased the product.

When Cleaning the unit:
Wipe the unit using a dry, soft cloth when cleaning.

3
Guidance and manufacturer's declaration - electromagnetic emissions
The Model MKC-210HD is intended for use in the electromagnetic environment specified below. The customer or the user
of the Model MKC-210HD should assure that it is used in such an environment.
Item

Test Procedure

Limits

Result

AC Mains Terminal Continuous
Disturbance Voltage
(0.15 – 30MHz)

CISPR 11

Group1,
Class A

Complied

Radiated Electric Field Strength
(30 – 1000MHz)

CISPR 11

Group1,
Class A

Complied

AC Mains Terminal
Harmonics

IEC61000-3-2

Class A

Complied

AC mains Terminal
Voltage Fluctuation

IEC61000-3-3

Clause 5

Complied

Immunity test

Specification

Actual Performance

Result

Electrostatic discharge
IEC61000-4-2

±2, ±4,±6kV (contact)
±2, ±4,±8kV (air)

±2, ±4,±6kV (indirect contact)
±2, ±4,±6kV (direct contact)
±2, ±4,±8kV (air)

Complied

Radio-frequency
electromagnetic field
IEC61000-4-3

80MHz - 2.5GHz
3 V/m (1kHz, AM 80%)

80MHz - 2.5GHz
3.6V/m(unmodulated, r.m.s)
(1kHz, AM 80%)

Complied

AC power ports
±2kV (5/50ns)

±2kV (5/50ns,5kHz and 100kHz)

Complied

Signal ports
±1kV (5/50ns)

±1kV (5/50ns,5kHz and 100kHz)

Complied

AC power ports
±2kV (line-earth)
±1kV (line-line)
(90°/180°/270°)

±0.5, ±1, ±2kV (line-earth)
±0.5, ±1kV (line-line)
(90°/180°/270°)

Complied

AC power ports
0.15 - 80MHz,
3V (1kHz, AM 80%)

0.15 – 80MHz
3.15V (unmodulated, r.m.s)
(1kHz, AM 80%)

Complied

Signal ports
0.15 - 80MHz,
3V (1kHz, AM 80%)

0.15 – 80MHz
3.15V (unmodulated, r.m.s)
(1kHz, AM 80%)

Complied

3 A/m,50Hz and 60Hz

3.15 A/m, 50Hz and 60Hz

Complied

Electrical fast
transient/burst
IEC61000-4-4

Surge
IEC61000-4-5

Ratio-frequency
Conducted disturbances
IEC61000-4-6

Power frequency
magnetic field
IEC61000-4-8

Voltage dips
and short interruptions
IEC61000-4-11

>95% reduction, 0.5periods
60% reduction, 5periods
30% reduction, 25periods
(Changes to occur at 0degree
crossover Point of the voltage
waveform)

>95% reduction / 0.5periods
(0°/180°)
60% reduction / 5periods (0°)
30% reduction / 25periods( 0°)

>95% reduction, 5s
(Changes to occur at 0degree
>95% reduction / 5ns(0°)
crossover point of the voltage
waveform)

Complied

Complied
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1. Name and Function of Each Part
1.1. Camera Head
1 1/3 C-mount

2 Camera Connector

MKC-210HD

4 Flange focus fixation screw

5 Screw hole for fixation

3 Flange focus adjustment ring

Side View

Rear View

1 1/3 C-mount

This is the mount for attaching the lens.
Allows mounting of various C-mount lens and microscope adapters.
2 Camera Connector

Connects the camera connector of special camera cables.
Be aware that the size of the camera connector differs on the camera head side and CCU side.
3 Flange focus adjustment ring

Flange focus (distance from the lens mounting surface to the photographed surface) adjustment ring. Adjust
the flange focus to use the lens focus function under optimal conditions.
4 Flange focus fixation screw

Fixes the flange focus adjustment ring.
Caution
Loosen when adjusting the flange focus, and tighten up to fix after adjustment.
Over-tightening may damage the screw.
5 Screw hole for fixation

Screw holes to fix the camera head. Arranged one above the other.
Caution
The screw depth is about 3.0mm.
Using an overly long screw may cause it to come into contact with the flange focus adjustment ring, so
please be careful.
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1.2. Front Panel of Camera Control Unit (CCU)
1 POWER button 2 AWB button

3 GAIN button

4 PAINT/AE button

9 FUNCTION/SET button

FUNCTION/SET
AWB

GAIN

PAINT/AE

MKC-210HD

1

POWER

4

2
3

BARS

5 BARS button

FREEZ

MENU

SCENE

6 FREEZ button 7 SCENE button 8 Arrow keys 10 MENU button

1 POWER button

This is the power button of the MKC-210HD.
2 AWB button

To execute Auto White Balance. (See page 12）
3 GAIN button

Automatic gain control to insure that the output level of the image signal is always constant in relation to the
brightness of the photographic image. If this function is used effectively, the GAIN button remains lit green. (See
page 15)
4 PAINT/AE button

Possible to adjust the AE level and the intensity of red and blue of the image. (See pages 13, 14)
5 BARS button

Output an internal color bar signal of the camera to a color monitor. Can be used to adjust the color monitor
brightness, contrast, etc. (See page 16)
6 FREEZ button

Possible to freeze the screen image. (See page 15)
7 SCENE button

Used when selecting a scene file. (See page 17)
8 Arrow keys

Used to select scene files or operate the menu.
9 FUNCTION/SET button

Press to determine the item you wish to set with the menu displayed. Refer to “Menu Operation”.
10 MENU button

To display the menu that the user can set as desired on the monitor.
Select an item you want to set with 8 Arrow key and define it with 9 Menu Switch for menu items you can
set.
Refer to “Menu Operation” (Page 18) for further detailed operations.
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1.3. Rear Panel of Camera Control Unit (CCU)
1 VBS Output

2 S-VIDEO OUT

Connector

Connector

3 RS-232C

4 FOOT Switch

Connector

Connector

RS-232C

VBS

IRIS

Connector

HD SDI

2

GENLOCK

CAMERA

SYNC

DVI

POWER

7 DVI-D Output 13 Options 8 HD-SDI Output 9 GEN LOCK 10 SYNC

Connector

6 Camera

Connector

FOOT SW

Y/C

1

5 IRIS

Connector

Connector

11 POWER

12 Cable

Connector Connector

Holder

1 VBS Output Connector (SD)

Connects with VBS input monitor, etc. A VIDEO cable (optional) is required for connection.
2 S-VIDEO Output Connector (SD)

Connects with S-VIDEO input monitor, etc. An S-VIDEO cable (optional) is required for connection.
3 RS-232C Connector

Connects with PC unit, etc. A cross cable is required for connection.
4 FOOT Switch Connector

To connect the FOOT SW (option) cable extension from the foot switch.
5 IRIS Connector

Connects the IRIS cable of a special microscope adapter.
6 Camera Connector

Connects with camera connector of the special camera cable.
Be aware that the size of the camera connector differs on the camera head side and CCU side.
7 DVI-D Output Connector

Connects with DVI-D input monitor, etc. A DVI-D cable (optional) is required for connection.
8 HD-SDI Output Connector (2 Lines)

Connects with HD-SDI input monitor, etc. The same image is input in two 2 lines.
When connecting use a coaxial cable with a characteristic impedance of 75 Ohms.
9 GEN LOCK Connector

When using while synchronized with the phase of another system’s image, inputs synchronizing signals from
the other system. Equivalent to Three-Phase Synchronization (HD).
10 SYNC Connector

When using while synchronized with the phase of another system’s image, outputs synchronizing signals
from the other system. Equivalent to Three-Phase Synchronization (HD).
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11 POWER Connector

DC12V input. Connect the accessory AC adapter.
12 Cable Holder

After passing the power cable through the cable holder, connect to the power connector 11 to prevent the
cable from falling off during use.
12 Options

It is possible to mount the two types of optional modules listed below.
・IP ENCODER module
・DVI module
15 SD CARD

SD CARD

14 ETHERNET

ETHERNET

DVI

16 DVI-D Output Connector

DVI

DVI

14 ETHERNET Connector (RJ45)

Can be used with Ethernet 10Base-T/100Base-TX.
For connection with other devices, please connect a cable of category 5 or higher.
15 SD CARD

This is the insertion port for the SD card.
* The SD card is not included in the equipment spec.
Note
* Please note we assume no responsibility for warranty when videos are not saved due to any failure of
this machine and SD card.
* Although in the following cases, saved data may be damaged (lost), please note we assume no
responsibility for damage and so on caused by data corruption and so on:
● When an SD card is used improperly.
● When an SD card is not properly inserted into the equipment.
● When an SD card is subject to electronic and mechanical shock or force.
● When an SD card is removed or power is turned off during access to the SD card.
16 DVI-D Output Connector

Connects with DVI-D input monitor,etc. A DVI-D cable (option) is required for connection.

10

2. Operation
2.1. Connection Example
MKC-210HD
Camera Head

Foot Switch

HDD/DVD recorder

D

-210H

MKC

S-VIDEO cable

Camera cable

MKC-210HD CCU
RS-232C

VBS

FOOT SW

Y/C

IRIS

1

DVI

DVI-D cable

HD SDI

2

GENLOCK

CAMERA

SYNC

POWER

HD-SDI compatible
Coaxial cable
Accessory AC
adapter

DVI compatible monitor

HD-SDI compatible monitor

* Terminate the output from VIDEO OUT at 75ohms on the receiver side.
* For connection of the power supply, be sure to use the accessory AC adapter.
Caution at connection
● Before connecting, please make sure you switch off the camera body.
● For the AC adapter for connection, please use the following:
Manufacturer: SINPRO ELECTRONICS
Model name: MPU30-105-P01J
● For exclusive camera head connection goods. Using heads other than that specified may result in failure.
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2.2. Electrical Connection
1. Before turning on the power, confirm that the external devices (camera head, monitor, etc.) are
correctly connected.
2. Turn on power supply to the monitor and other external equipment.
3. Turn on power supply (POWER switch) of CCU.
● Connect the accessory AC adapter to the power connector on the back of the CCU.
● Even if the power connector on the back of the CCU is connected, the power is turned on automatically.
● When the power goes on, the power button lights green.
● If the Power button light is on and the Power button is pressed, it is possible to turn off the power.
● Immediately after turning on the power, the initialization operation of the CCU and camera head is carried
out automatically. During this time, an unstable display is displayed on the monitor screen. This does not
indicate a technical problem.
4. The video image from the camera is output under the same setting condition with the last use.
● When power is turned off in the state of still screen picture, that state will not be held even if power is
turned on again, and MKC-210HD is set to the normal shooting state.
* When moving the CCU, be sure to turn off the POWER, disconnect the power plug and remove the
connecting cable between equipment beforehand.
* If the cable comes loose during use, repeat the steps described above.
CAUTION

Caution for Camera cable connection and disconnection
Turn off the power of MKC-210HD when you connect or disconnect the camera cable. If the
CCU is turned on, it may cause the fault of MKC-210HD.

NOTE: Phenomenon on video image
MKC-210HD may happen following phenomenon on its video image. It is not failure but it is
because of employing CMOS sensor.
When its sensitivity gain is going up, it may appear high lighting dots. In case under high
temperature condition, it may be remarkable.
It may appear horizontal stripe pattern or flicker on a video image under the fluorescent
lighting. In this case, please use manual electrical shutter of 1/100 (50Hz area). It will be
reduce, but please note that it will not disappear at all.
In case of fast moving object on a video image, it may appear distortions.
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2.3. Setting White Balance
When using MKC-210HD for the first time, or when the light source has been changed, adjust the White
Balance. The white balance can be adjusted automatically.
<Operation>
1. Shoot a white photographic object on the screen largely, and press AWB button.
● During automatic adjustment, the AWB button is lit green.
AWB button

FUNCTION/SET
AWB

GAIN

PAINT/AE

MKC-210HD

1

POWER

4

2
3

BARS

FREEZ

MENU

SCENE

● If “AWB” is displayed on the monitor screen and it ends normally, “AWB COMPLETED” is displayed.

AWB BUSY

AWB COMPLETED

● If “AWB ERROR” is displayed, AWB adjustment was not carried out for the following reasons. Execute
AWB again.
• If the image level is too low.
• If the image level is too high.

2. When automatic adjustment finishes, the AWB button extinguishes automatically.
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2.4. Adjustment PAINT
After white balance adjustment it is possible with the MKC-210HD to carry out fine adjustment of the red level
and blue level to adjust the desired tint.
<Operation>
1. Press PAINT/AE button.
● If the paint adjustment function is active, the button is lit green.
● If the button is already lit, it is not necessary to push it.
PAINT/AE button (Lit)

FUNCTION/SET
AWB

GAIN

PAINT/AE

MKC-210HD

1

POWER

4

2
3

BARS

FREEZ

MENU

SCENE

2. Use the arrow keys to adjust the red and blue color.
● Use the ⇧ / ⇩ keys to adjust the red color and the ⇦ / ⇨ keys to adjust the blue color.

Dark red
1
4

Dark blue

2
3

Light red

Light blue

Paint R
Paint B

0
0

● The above adjustments are temporary setting changes. They return to the original values if the power is
turned off.
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2.5. Adjustment AE LEVEL
It is possible with the MKC-210HD to automatically adjust the shutter speed, gain and iris according to the set
exposure level. By increasing the level when the screen is too dark and decreasing the level when the screen is
too bright, the screen will be easier to view. This function is active when the GAIN/SHUTTER is in AUTO.
<Operation>
1. Confirm that the PAINT/AE button is not lit.
● If it is lit, press the PAINT/AE button to extinguish it.
PAINT/AE button (Extinguished)

FUNCTION/SET
AWB

PAINT/AE

GAIN

MKC-210HD

1

POWER

4

2
3

BARS

MENU

SCENE

FREEZ

2. Use the arrow keys to adjust the AE level.
● Use the ⇧ / ⇨ keys to raise the AE level.
● Use the ⇩ / ⇦ keys to lower the AE level.
● The ⇧ and ⇨ keys, as well as the ⇩ and ⇦ keys have the same function.

AE level is raised.
1
4

2
3

AE level is lowered.

AE LEV

0

● The above adjustments are temporary setting changes. They return to the original values if the power is
turned off.
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2.6. Adjustment Auto Gain
It is possible with the MKC-210HD to automatically adjust the image brightness during photography in relation to
the brightness of the photographic subject. This makes it possible to constantly maintain an image of the ideal
brightness.
The maximum gain value can be set between 3 dB and 18 dB in units of 3 dB.（Refer to Section 3.3. "AE Mode")
<Operation>
1. Press GAIN button.
● The automatic gain adjustment function immediately becomes active.
● If the automatic gain adjustment function is active, the GAIN button is lit green.
GAIN button

FUNCTION/SET
AWB

GAIN

PAINT/AE

MKC-210HD

1

POWER

4

2
3

BARS

FREEZ

MENU

SCENE

2. To stop automatic gain adjustment, press the GAIN button again.
● The GAIN button extinguishes.
White spots may appear on the screen when increasing the gain. This is a
characteristic of the sensor and does not indicate a technical problem.

2.7. Freeze output
It is possible on the MKC-210HD to temporarily stop moving image output and switch to freeze frame output.
<Operation>
1. Press FREEZ button.
● Immediately switches to freeze frame output.
● During freeze frame output, the FREEZ button is lit green.

FUNCTION/SET
AWB

GAIN

PAINT/AE

MKC-210HD

1

POWER

4

2
3

BARS

FREEZ

SCENE

FREEZ button
2. To return to moving image output, press the FREEZ button again.
● The FREEZ button extinguishes.

MENU
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2.8. Color bar output
It is possible with the MKC-210HD to output a color bar. This is used when adjusting the color monitor
brightness, contrast, etc.
<Operation>
1. Press BARS button.
● Immediately changes to color bar output.
● During color bar output, the BARS button is lit green.

FUNCTION/SET
AWB

GAIN

PAINT/AE

MKC-210HD

1

POWER

4

2
3

BARS

FREEZ

SCENE

BARS button
2. To return to camera images, press the BARS button again.
● The BARS button extinguishes.

MENU
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2.9. Scene File Selection
By storing settings often used on the MKC-210HD beforehand in a scene file, it is possible to read them at any
time. A maximum of four scene files can be stored.
<Readout operation>
1. Press the SCENE button. The button is lit green.
● The arrow key is lit that corresponds to the presently selected scene file.

FUNCTION/SET
AWB

PAINT/AE

GAIN

MKC-210HD

1

POWER

4

2
3

BARS

FREEZ

MENU

SCENE

SCENE button
2. Use the arrow keys to select the scene files.
● The numerical value displayed next to the arrow keys is the number of the scene file.
● The arrow key is lit that corresponds to the selected scene file.
● The scene file setting is immediately reflected.

Scene File 1
1
4

2

Scene File 2

3

Scene File 3

Scene File 4
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3. Menu Operation
MKC-210HD has various useful and practical functions. The user can select and set these functions on the
menu. The basic operation is as follows.

3.1. Operation Method
1. Pressing the Menu switch on the front panel of CCU displays a menu on the monitoring screen, on which
various camera functions can be set.
Setup Menu
Video Adjust
AE Mode
Detail
Video Setting
Picture Setting
Scene File
Foot Switch
White Balance
IP-ENC Setting*1
Miscellaneous
Version Information

*1: The IP-ENC item is only displayed if the optional substrate is mounted.
2. Use the ⇧ / ⇩ keys on the front of the CCU to select the item and then press the SET button to enter the
submenu screen. The setting values of the setting items can be changed with the ⇦ / ⇨ keys.
Selection of items

FUNCTION/SET

Determining the selected items
1
4

2
3

MENU

Display/non-display of the
menu screen

Changing setting values
* If the Menu button on the front of the CCU is pressed during display of the menu screen, the settings are
stored and the menu screen stops.
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3.2. Video Adjust
Used to adjust the level of black, red and blue of video picture.
Video Adjust
Quit
Pedestal
Video Level
Gain Offset Red
Gain Offset Blue

Item
Pedestal

Setting Value

0
0
0
0

Description
Adjusts the black level. Normally not used.

-80 to 80 If the value is increased, the black sections become brighter.
Video Level

Adjusts the image signal level. Normally not used.
-64 to 63 Increasing the value produces a bright image. Decreasing the
value produces a dark image.

Gain Offset Red

Adjusts the red level. This is the same function as paint
adjustment on the front of the CCU.
-128 to 127 Increasing the value causes red to be displayed more vividly.

Gain Offset Blue

Adjust the blue level. This is the same function as paint
adjustment on the front of the CCU.
-128 to 127 Increasing the value causes blue to be displayed more vividly.
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3.3. AE Mode
Used to adjust the electronic shutter and automatic sensitivity setting.
AE Mode
Quit
Shutter Control
Manual Shutter
Auto Shutter Limit
AE Level
AE Speed
Peak Ratio
Area Select
Gain Control
AGC Gain Range
Normal Gain

Item
Shutter Control

Setting Value

AUTO
OFF
1/4000
0
MID
-128
MIDDLE
AUTO
18dB
-6dB

Description
This item concerns automatic adjustment of the shutter speed.
If the shutter speed is slowed down, the brightness changes
in relation to the speed. Likewise, in the case of a discharge
lighting source such as a fluorescent lamp, the flicker may
increase.

AUTO Automatically adjusts to the ideal shutter speed in relation to
image brightness.
FIX Set to the shutter speed always set by the user. The shutter
speed is carried out in the item entitled Manual Shutter.
Manual Shutter

The shutter speed when the shutter control is in FIX is set
here. (If set to AUTO, it is ignored). It is usually used in the
OFF setting.
OFF The shutter speed is set at about 1/60 seconds.
1/100 to The shutter speed is constantly set to a fixed value ranging
1/10000 between 1/100 sec and 1/10000 sec.

Auto Shutter Limit

1/100 to If the Shutter Control is on Auto, it is possible to set the upper
1/4000 limit of the shutter speed.

AE Level

-128 to 127 If the Shutter Control or Gain Control is in AUTO, it is possible
to make fine adjustment of the shutter speed in relation to the
level set here. If the screen is too dark, the value is increased,
and if the screen is too bright the value is decreased.

AE Speed

Sets the control speed if the Shutter Control or Gain Control is
in AUTO.
MID Adjusts to the standard speed.
SLOW Adjusts more slowly than MID.
FAST Adjusts more quickly than MID.
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Item
Peak Ratio

Setting Value

Description

-128 to 127 Possible to adjust the photometry method if the Shutter
Control or Gain Control is in AUTO. With +127 there is peak
photometry, and with -128 there is average photometry.
If the background area is almost completely dark and
the photographic subject is bright, set to the peak light
measurement side. If the brightness change for the entire
screen is low, set to the average light measurement side.
Possible to adjust the extent of the photometry area. Carries
out automatic adjustment of the shutter and gain, etc. based
on the image in the frame displayed in the screen.

Area Select

MID About 40% of the screen center is the photometry area.
WIDE About 60% of the screen center is the photometry area.
FULL The entire screen is the photometry area.
USER.. Allows arbitrary setting of the photometry area. Press the SET
button to enter the setting screen.
* For details on settings, see Section 4.2 "Manual setting of
photometry frame".
NARROW About 10% of the screen center is the photometry area.
This item concerns automatic adjustment of gain.
If a dark subject has been photographed, it is possible to
adjust the brightness.

Gain Control

AUTO The gain is adjusted automatically in relation to the brightness
of the image input so that the output level constantly remains
a set value.
FIX Automatic adjustment of gain is not carried out.
AGC Gain Range

3dB to 18dB Setting of maximum gain with Gain Control in AUTO.

Normal Gain

-6dB to 6dB Normal gain setting. This setting is always used regardless of
the Gain Control setting. The higher the value the brighter the
image, although noise can more readily increase.

It is used when you want to increase the sensitivity.
Although the sensitivity will increase by a factor of two,
horizontal resolution will be slightly lower.

High Sensitivity

ON
OFF

Carries out increase the sensitivity.
Does not carry out increase the sensitivity.
It is used when you want to increase the sensitivity.
Although the sensitivity will increase by a factor of two,
vertical resolution will be slightly lower.

Line Mix

ON

OFF

Carries out increase the sensitivity.
Does not carry out increase the sensitivity.
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3.4. Detail
Used to adjust detail enhancement.
Detail
Quit
Detail
Detail Gain
Boost Frequency

Item
Detail

Setting Value

ON
0
16MHz

Description
Sets the contour enhancement. If contour enhancement is
carried out, the image is clearer and easier to view. Set it to
ON usually.

ON Carries out contour enhancement.
OFF Does not carry out contour enhancement.
Detail Gain

To adjust the detail enhancement level.
-128 to 127 Increasing the value results in a sharper image.

Boost Frequency

Sets the boost frequency for contour enhancement.
2MHz to The lower the value, the easier it is to carry out contour
28MHz enhancement on the entire screen.
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3.5. Video Setting
Sets the video signal.
Video Setting
Quit
Format
DVI Setting
Gamma
Master Gamma
Color Saturation
Color Saturation Gain
Genlock H Phase
Genlock V Phase

Item
Format

59.94Hz
1080p
ON
0
ON
0
0
0

Setting Value

Description
Selects the output signals HD SDI, DVI, VBS and Y/C. (Not
possible to change them individually). With VBS output, the
signal method is also changed.

59.94Hz Output at 59.94 Hz. VBS is output with the NTSC method.
50Hz Output at 50 Hz. VBS is output with the PAL method.
DVI Setting

Select the DVI output signal output format.
1080p Output the progressive signal.
1080i Output the interlace signal.

Gamma

If gamma correction is carried out, it is possible to cause the
caused the dark sections of the image to be displayed brightly.
Normally this is used in an ON setting.
ON Carries out gamma correction.
OFF Does not carry out gamma correction.

Master Gamma

Adjusts the degree of gamma correction. With a setting value
of 0, the value is γ= 0.45.
-128 to 127 The lower the value, the brighter the dark parts of the image
become.

Color Saturation

Sets the color intensity.
ON Adjusts the intensity of color set with Color Saturation Gain.
OFF Does not adjust the color intensity (normal color image).

Color Saturation
Gain

Adjusts the color intensity.
-64 to 63 The higher the value, the more intense the color. The lower
the value the more faded the color. With -64 it is monochrome.

Genlock H Phase

-128 to 127 Adjusts the horizontal phase for Genlock input.*1

Genlock V Phase

-128 to 127 Adjusts the vertical phase for Genlock input.*1

*1 For details, see Section 4.1 "External synchronization".
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3.6. Picture Setting
Setting of noise reduction, image inversion, electronic zoom and display position.
Picture Setting
Quit
DNR
H Flip
V Flip
Digital Zoom
Picture Shift H
Picture Shift V

Item
DNR

Setting Value

OFF
OFF
OFF
x1.0
0
0

Description
Noise reduction function setting.

OFF Noise reduction is not carried out.
- The noise reduction is set in the order of LOW→MID→HIGH.
With a HIGH setting, for example, the noise is less but the
remaining image will be prominent in case of a moving
photographic subject.
H Flip

Sets the horizontal inversion of the image.
ON Inverts to a horizontal direction for output.
OFF The horizontal direction becomes the normal rotation output.

V Flip

Sets the vertical inversion of the image.
ON Inverts to a vertical direction for output.
OFF The vertical direction becomes the normal rotation output.

Digital Zoom

Magnification setting for electronic zoom.
x1.0 to x4.0 The center of the screen is zoomed up in units of 0.1 power.

Picture Shift H

-32 to 32 The horizontal display position of the screen is adjusted in 1
pixel units.

Picture Shift V

-8 to 8 The vertical display position of the screen is adjusted in 1 pixel
units.
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3.7. Scene File
Possible to store and read the setting value information as a scene file. Possible to create a maximum of 4
scene files.
* For details on settings, see Section 4.3 "Scene File".
Scene File
Quit
Scene Number
Store Scene
Initialize Scene

Item

Setting Value

No.1
READY
READY

Description

Scene Number

-

Select and read the set scene file.

Store Scene

-

Store the set condition in the scene file.
Select the scene file you wish to set and press the SET button.

Initialize Scene

-

Select the scene file you wish to initialize and press the SET
button. If you select ALL, all scene files will be initialized.
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3.8. Foot Switch
Sets the operation when controlling the foot switch.
Foot Switch
Quit
Foot
Foot
Foot
Foot

Item
Foot Switch

Switch
Switch
Switch
Switch

Setting Value

1
2
3
4

NONE
NONE
NONE
NONE

Description
Carries out setting of operations when the foot switch is
operated. Foot switch operation responds up to 4, allowing
separate operation settings for each one.

NONE Nothing is carried out, even when the foot switch is operated.
FREEZE Outputs still images. Operate the foot switch again to return to
moving images.
SCENE FILE Switches the scene file selection.
H FLIP Outputs a horizontally inverted image.
V FLIP Outputs a vertically inverted image.
ROTATE Outputs an image inverted 180 degrees.
ZOOM IN Carries out electronic zoom-in.
ZOOM OUT Carries out electronic zoom-out.
SNAPSHOT Inserts still images on SD card with IP encoder (optional).
SHUT CONT. Switch the shutter control (AUTO/FIX).
GAIN CONT. Switch the gain control (AUTO/FIX).
IRIS CONT. Switch the iris control (AUTO/FIX).
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3.9. White Balance
Automatic adjustment of white balance and manual adjustment setting.
White Balance
Quit
WB Mode
Manual Gain Red
Blue

Item
WB Mode

AWB
-16
-28

Setting Value

Description
Sets white balance operation.

AWB The white balance is adjusted automatically. Press the SET
button when this item is selected.
MANUAL Manual adjustment of white balance. Adjustment is carried out
with Manual Gain Red/Blue.
Manual Gain Red

Adjusts the red gain.
-128 to 127 Increasing the value causes red to be displayed more vividly.

Manual Gain Blue

Adjusts the blue gain.
-128 to 127 Increasing the value causes blue to be displayed more vividly.
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3.10. IP-ENC Setting（Only valid when optional substrate is mounted）
IP-ENC Setting
Quit
IP Address
Encoder Mode
JPEG Quality

Item

ENTER
SNAPSHOT
A

Setting Value

Description

IP Address

Displays the sub menu.

Encoder Mode

Select the image compression method.
SNAPSHOT Compress with JPEG method and record on the SD card.
STREAMING Compress with the H.264 method and distribute the image.
Sets the image quality if the compression method is set to
JPEG.

JPEG Quality

A to E Five steps from A (highest image quality) to E (lowest
image quality).

IP Address
Quit
IP Address
Subnet Mask

Item

192.168.001.100
255.255.225.000

Setting Value

Description

IP Address

Sets the IP Address.

Subnet Mask

Sets the Subnet Mask.
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Do you change the IP Address ?
Cancel

OK

A message appears on the screen asking for confirmation.
For a scene that can be changed select [OK]. To stop, press [Cancel] and then press the Set button.
* Only displayed if the IP address is changed.

Note
● The setting values such as IP address and sub-net mask will vary according to the network environment
of the customer. Please consult with the network manager.

Caution at network connection
The IP ENCODER module (option) is for use in connection with the network.
To protect the system from harm specific to the network connection, please conduct sufficient security
measures under your own responsibility.
Network-specific harm includes leak/flow of information obtained by this device, disruption due to
unauthorized access, system halt and so on.
The measures include the following, but please implement sufficient other measures under your own
responsibility:
● Do not install in any place where cables can be easily moved/replaced
● Maintain network safety (firewall and so on)
● Conduct regular anti-virus checks on all PCs to be connected to the network
● Restrict the number of users connecting via PCs (e.g. password setting)
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3.11. Miscellaneous
Adjustment screen for other functions.
Miscellaneous
Quit
Center Marker
Menu Lock
Cancel
Initialize(exp.Scene)

Item
Center Marker

Setting Value

OFF
OFF
READY
READY

Description
Center marker display setting.

ON Center marker is displayed on the screen.
OFF Center marker is not displayed.
Menu Lock

Menu lock.
ON Sets a state in which no settings other than Menu Lock
can be changed. During Menu Lock, a red lock mark is
displayed in the upper right of the menu screen.
OFF Sets to a state in which all menu item settings can be
changed.

Cancel

Initialize(exp.Scene)

Press the [READY]→[START] ⇦ / ⇨ keys and then press
the [SET] button.
The menu items return to the stored state for the former
time.
- Press the [READY]→[START] ⇦ / ⇨ keys and then press
the [SET] button.
All setting values other than the scene file are initialized.
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3.12. Version Information
To display the software version of this camera.
Version Information
Quit
Model
CCU Firmware
CCU FPGA
Head FPGA
IP-ENC*1

*1 Only displayed if IP-ENC module is mounted.

MKC-210HD
V1.00
V1.00
V1.00
V1.00
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4. Advanced Usage Methods
4.1. External synchronization
If this equipment is used with external synchronization, SYNC is input to the GENLOCK terminal on the back
of the CCU. If SYNC is input to the GENLOCK terminal, the camera automatically switches from internal
synchronization to external synchronization.
SYNC input condition: 3-value SYNC: 0.6 Vp-p/75 Ohms

4.1.1. Wiring connection example
Prepare two sets of CCU and camera for the MKC-210HD. Connect the SYNC connector of CCU (Master) and
the GENLOCK connector of CCU (Slave) with the coaxial cable.
Camera
(Master)
D

-210H

MKC

CCU (Master)
RS-232C

VBS

FOOT SW

Y/C

IRIS

1

HD SDI

GENLOCK

2

DVI

CAMERA

SYNC

POWER

Coaxial cable
(Sold separately)

Camera
(Slave)

SYNC Connector

CCU (Slave)
RS-232C

VBS

FOOT SW

Y/C

IRIS

1

DVI

HD SDI

2

GENLOCK

D

-210H

MKC

CAMERA

SYNC

POWER

GENLOCK Connector
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4.1.2. Setting
Measure the SYNC output waveforms of the CCU master and slave and adjust the PHASE so that the H/V
phases match. When adjusting, adjust the slave side (side on which the GENLOCK connector is connected).
Phase adjustment is not required on the Master side.
Master SYNC

Adjust phase

Slave SYNC

4.2. Manual setting of photometry frame
The Photometry frame can be changed within a random range. By adjusting the photometry frame, automatic
adjustment of the image to match the usage environment is possible.

4.2.1. Setting
Select [AF Mode]→[Area Select]→[USER] from the menu and press the SET button. The system goes to the
manual setting screen for photometry frame.

Quit
Position
Size

Possible to set the position and size of the photometry frame. When setting is finished, select QUIT and press
the SET button to finish setting.
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Position Setting
Select Position and press the SET button to adjust the position of the photometry frame. The frame size is not
changed.

Quit
Position
Size

Movement of frame

Use the ⇧ / ⇨ / ⇩ / ⇦ keys to adjust the position. When adjustment is finished, press the SET button to
complete adjustment.
Size Setting
Select Size and press the SET button to adjust the size of the photometry frame. The upper left corner of the
frame is fixed. The lower right corner can be moved for adjustment.

Quit
Position
Size

Changing the frame size

Use the ⇧ / ⇨ / ⇩ / ⇦ keys to adjust the size of the frame. When adjustment is finished, press the SET button
to complete adjustment.
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4.3. Scene File
This device allows setting of up to four scene files chosen according to photographic conditions. It is also
possible to return to the condition at the time of shipment from the factory.

4.3.1. Storage of Scene File
The scene file can be created from the menu. Because the present setting is stored in the scene file, adjust
beforehand to the setting you wish to store.
Use [Scene File] → [Store Scene] to select No. 1 to No. 4 from the menu and then press the SET button.
When the menu is finished, it will be automatically stored to the scene files being selected. (Refer to Section 3.7
"Scene File").

4.3.2. Initialization of Scene File
Use [Scene File] → [Initial Scene] to select No. 1 to No. 4 from the menu and then press the SET button.
The selected scene file is immediately initialized.

4.3.3. Setting of Scene File
To use the stored scene file operate the front panel (See page 17) or the foot switch (See page 26) or the menu
[Scene File] (See page 25) .

4.4. Snapshot (requires optional substrate)
Possible to record still images (JPEG) to SD card. The picture quality setting can be changed with [JPEG
Quality] from [IP-ENC setting] on the menu.
* The SD card is not included in the equipment spec.

4.4.1 SD Card Recording
Possible with the following two operations to record to the SD card.
● Operation from CCU front panel.
1 Press FUNCTION button.
2 Press the ⇧ key to store the still image to the SD card.
②

①
FUNCTION/SET

1
4

2
3

MENU

● Operation of foot switch
For setting, select [SNAPSHOT] with [FOOT Switch] on the menu.

4.4.2. For cards on which recording is finished
It is possible to view the recorded images on a PC.
* This device does not include a function for displaying images.
A PC is required to view images.
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5. Specification
5.1. Ratings
(1)
(2)

Lens Mount
Image Pickup Device

(3)
(4)
(5)

Scanning System
Aspect Ratio
External Sync

(6)

Output Video Signal
HD Output

SD Output

(7)
(8)
(9)

Camera Cable
Auto Iris
Input Control Signal

(10)
(11)
(12)
(13)
(14)

Power Requirement
Power Consumption
Operating Temperature
Storage temperature
Dimensions/Weight

(15) Accessories
(16) Option

C-Mount
1/3 type, CMOS sensor (Rolling Shutter)
Effective Pixels :1920× 1080
Color filter: RGB method
Progressive Scan
H16 : V9
Tri-Sync: 0.6Vp-p / 75 ohms
Note: The color frame of the down converter output is not locked.
HD-SDI (2 Lines) : 0.8Vp-p / 75 ohms
DVI
(1 Line) : 1920×1080P 59.94 / 50
1920×1080I 59.94 / 50
SD-VBS (1 Line) : 1.0Vp-p / 75 ohms
SD-Y/C (1 Line) : Y: 1.0Vp-p / 75 ohms
C: 0.286Vp-p / 75 ohms
5m (Standard option) Round connectors, 20 pins
DC Iris, Round connectors, 4 pins
RS-232C (1 Line) D-Sub 9pin Male
FOOT SW (1 Line) D-Sub 9pin Female
DC12V ± 10%
Approx. 18W or less
0°C to +40°C
-20°C to +70°C
Camera Head: W31×H31×D39mm / 60g or less
CCU:
W170×H58×D200mm / 1.1kg or less
AC adapter, Instruction Manual
IP ENCODER Module
DVI Module
Camera cable (10m)

5.2. Performance
(1)
(2)
(3)

Resolutions
S/N Ratio
Sensitivity

Horizontal 900TV Lines (1080I 59.94/50)
50 dB (γ and Detail OFF)
Standard 2000Lux F7 / 3200K or more

37

5.3. Functions
(1)
(2)
(3)
(4)
(5)
(6)
(7)
(8)
(9)
(10)
(11)
(12)
(13)
(14)

Gain Control function (AUTO/FIX) Max.18dB
White Balance function (AWB/MANUAL)
Shutter Control function (AUTO/FIX)
IRIS Control (For Shutter IRIS, DC IRIS)
Photometry area variation function
Character display function (English, German, French, Spanish)
Internal freeze function
Internal color bar
Image tilt function (left/right, up/down, left-right/up-down)
Noise reduction function
GENLOCK function
Flange back adjustment function
Down converter function
Electronic zoom function
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6. External Appearance
6.1. Camera Head
Unit: mm
6

14

2-M3

36±2

15.5±0.5

31±2

31±2

MKC-210HD

14

6

2-M3

6.2. CCU
Unit: mm
58±3

IRIS

GAIN

FREEZ

SYNC
1

PAINT/AE

SCENE

RS-232C

HD SDI

2

GENLOCK

AWB

BARS

FOOT SW

CAMERA

MKC-210HD

POWER

POWER

200±4

170±3

4
1

3
MENU

FUNCTION/SET

DVI

Y/C

2
VBS

(8)
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